How To Contact your Local Black Box

Italy:
Black Box Italia S.P.A
Tel: 02.23.400.280
Fax: 02.23.400.219
Web Site: www.blackbox.it

Australia:
Black Box Catalog Australia PTY LTD
Tel: 039879 7180
Fax: 039870 3955

Deutschland:
Black Box Deutschland
Tel: 0811/5541-0
Fax: 0811/5541-499
Web Site: www.blackbox deutschland.com

Brazil:
Black Box Do Brasil
Tel: (011) 5515-4000
Fax: (011) 5515-4002
Web Site: www.blackbox.com.br

Switzerland:
Datacom Black Box Services AG
Tel: 055 451 70 70
Fax: 055 451 70 75
Web Site: www.black-box.ch

Canada:
Black Box Canada Corp.
Tel: 6416-736-8000
Fax: 6416-736-7348
Web Site: www.blackbox.com

Netherlands:
Black Box Datacom BV
Tel: 030-3417700
Fax: 030-3417777
Web Site: www.blackbox.nl/

Mexico:
Black Box De Mexico S.A. de C.V
Tel: (5) 420-8-00
Fax: (5) 420-8-23
Web Site: www.blackbox.com.mx

Belgium:
Black Box
Tel: 02/735.85.50
Fax: 02/735.82.12
Web Site: www.blackbox.be

Japan:
Black Box Catalog
Tel: (03) 3820-5011
Fax: (03) 3820-3010
Web Site: www.blackbox.co.jp/

France:
Black Box Catalogue
Tel: 0145.60.67.00
Fax: 0145.60.67.47
Web Site: www.blackbox.fr

Spain:
Black Box Comunicaciones S.A.
Tel: 91 665 0200
Fax: 91 661 84 35
Web Site: www.blackbox.es

U.S.A:
Black Box Corporation
Tel: 724-746-5500
Fax: 724-746-9746
Web Site: www.blackbox.com

Chile:
Black Box Chile
Tel: 6680 141
Fax: 6680 140
Web Site: www.Blackbox.cl

TECHNICAL: 0118 965 6000
**Title Page**

<table>
<thead>
<tr>
<th>Item</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>2.</td>
<td>System Requirements</td>
<td>6</td>
</tr>
<tr>
<td>3.</td>
<td>Motherboard BIOS Settings</td>
<td>7</td>
</tr>
<tr>
<td>4.</td>
<td>Installation</td>
<td>8</td>
</tr>
<tr>
<td>4a.</td>
<td>Pre-Installation Check</td>
<td>8</td>
</tr>
<tr>
<td>4b.</td>
<td>Connect GlrBIL to a PC</td>
<td>8</td>
</tr>
<tr>
<td>4c.</td>
<td>Installation Instructions Windows 95</td>
<td>8</td>
</tr>
<tr>
<td>4d.</td>
<td>Testing the GlrBIL with Windows 95</td>
<td>9</td>
</tr>
<tr>
<td>4e.</td>
<td>Installation Instructions Windows 95 &amp; Windows 98 SE</td>
<td>9</td>
</tr>
<tr>
<td>4f.</td>
<td>Testing the GlrBIL with Windows 95</td>
<td>10</td>
</tr>
<tr>
<td>4g.</td>
<td>Installation Instructions Windows 2000</td>
<td>11</td>
</tr>
<tr>
<td>4h.</td>
<td>Testing the GlrBIL with Windows 2000</td>
<td>12</td>
</tr>
<tr>
<td>4i.</td>
<td>Using the GlrBIL with Windows 95/98 applications</td>
<td>12</td>
</tr>
<tr>
<td>5.</td>
<td>Troubleshooting</td>
<td>13</td>
</tr>
<tr>
<td>5a.</td>
<td>PSION Series 5 / 5mx / 7 Additional Note</td>
<td>15</td>
</tr>
<tr>
<td>5b.</td>
<td>Establishing The Infrared Link</td>
<td>15</td>
</tr>
<tr>
<td>5c.</td>
<td>Troubleshooting an Infrared Link with the Psion Series 5</td>
<td>16</td>
</tr>
<tr>
<td>6l.</td>
<td>GlrBIL Additional Information - Frequently Asked Questions</td>
<td>17</td>
</tr>
<tr>
<td>7l.</td>
<td>A final word about Virtual Ports and Direct Infrared Support</td>
<td>19</td>
</tr>
</tbody>
</table>

**Introduction**

The Black Box GlrBIL adapts a standard RS232 serial port on a PC to enable infrared communications with other IrDA compatible devices. This allows the exchange of data between two machines whilst eliminating the need to plug in extra cables or use floppy disks. Most laptop and handheld computers are equipped with infrared communications which means, for example, data can be shared quickly and conveniently between the desktop and the mobile computer.

The GlrBIL automatically supports communication links up to 115,200 bits per second over a physical distance of 1 metre. The GlrBIL can exchange data between any IrDA device within a 30 degree conical area of it's window. The efficient transceiver design within the GlrBIL allows the unit to be self powered from the RS232 serial port which, therefore means no external power source is required.

Installation is straightforward once the GlrBIL has been plugged into a vacant serial port and the set-up program, included on the floppy disk, is run. (Windows 95 and Windows 98 ONLY). The GlrBIL will then be ready to start working with infrared communications.

**Note:** Windows 2000 users must not use the drivers in the floppy disk. Windows 2000 has the GlrBIL drivers included in its database.
System Requirements

The contents of the G1rBIL Infrared Communications Kit include:

One G1rBIL infrared Transceiver Module, with integral lead and connector (9way D type).

One G1rBIL Software Driver Disk for use with Windows 95/98 ONLY.

In order to use the G1rBIL you must have:


A vacant RS232 Serial (COM) Port on the PC.

Note: For the G1rBIL to support the maximum data transfer rate of 115.2 Kbps the serial port should have 16550 compatible UART capabilities. (Most older Pentium based machines and virtually all new PCs support fast serial data transfer.)

Motherboard BIOS Settings

Some of the latest available motherboards already have an option to support infrared built in to their BIOS. The BIOS settings control the UART used to communicate with the Infrared Devices, this is normally referenced as UART2 in the BIOS set up screen.

Since the G1rBIL will be plugged into a physical serial port, you must disable the infrared option and set UART2 to a COM setting (normally COM2).

Note: A UART is the name of the hardware on the motherboard used to control the serial ports.
Installation

4a. Pre-Installation Check

You must always remove any previously installed versions of the Microsoft Infrared Driver every time you wish to install the IR Driver. In some configurations of Windows you may already have support for infrared enabled, in which case you will need to remove the driver before installing the GriBIL driver. To check if infrared support has been enabled: On the Windows Start menu select “Settings” from which a sub menu should appear. Select “Control Panel” from the options shown. A Control Panel Window will appear showing a number of icons with text underneath them. Select the “Add/Remove Programs” Icon. An Add/Remove Programs Window will appear showing a list of all the programs registered as installed to the computer. If you can see “Microsoft Infrared Support Version 2”, or similar, select the program by highlighting it with a mouse click and then click the “Add/Remove” button. Windows may inform you that it needs to restart the computer, in which case click OK. When Windows restarts it would have removed any support for infrared. You may now proceed with the Driver Installation.

4b. Connect GriBIL to a PC

The GriBIL is designed to plug into the 9 way serial port on a PC. The serial port is often referred to as a COM port. A PC will usually have one or more COM ports each one being referenced as a number (e.g. COM 1, COM 2 etc.). Connect the GriBIL to a vacant COM port making a note of which COM port to which you have connected the GriBIL. Note: The GriBIL is fitted with a 9 way D type connector. It is possible to use the GriBIL with PCs that have 25 way D type connectors by using a 25-to-9 way connector adapter (available from Black Box).

4c. Installation Instructions Windows 95

Before beginning the software installation you must close down any running applications.

(a) Place the GriBIL Driver Installation Disk into the floppy drive and select “Run” from the Start menu.

(b) In the prompt box provided type “AtWIN95SETUP.EXE” to run the Setup program from the floppy disk. The Setup program will guide you through the installation of the GriBIL device.

(c) When the Installation Wizard asks you to choose a device select “A GriBIL device (GIL) – GriBIL Infrared Adapter”. Later on during the installation process you must specify which COM port to which you have physically connected the GriBIL. You will be given a choice to select an available port from a list. The Installation Wizard will continue with the installation and should find new hardware.

(d) It will then add a new “virtual COM port and LPT port” to your computer. Accept the default values of COM4 and LPT20 as the values of the two new infrared ports. COM4 is the new infrared Serial Port and LPT20 is the new infrared Parallel Port. Both of these new ports send and receive data through the GriBIL.

(e) If the Installation Wizard did not find the infrared devices it will be necessary to restart the computer. During the Windows boot procedure the new infrared ports should be automatically assigned.

(f) Installation of the GriBIL Infrared Drivers is now complete.

4d. Testing the GriBIL with Windows 95

To test the GriBIL Driver Installation you must activate the GriBIL from the “Infrared Monitor”. Select “Settings” from the Windows Start menu and select “Control Panel”. The Control Panel window will appear showing a number of different icons. Double-click the “Infrared” icon. The Infrared Monitor window should appear. If the Infrared Monitor did not appear it may be because you selected an incorrect COM port. Click OK and the Infrared Monitor will appear then click the Options tab and choose a different COM port. The COM port you select must be the same port to which the GriBIL is connected. On the Infrared Monitor window select the “Options” tab and ensure the “Enable Infrared Communications” check box is enabled. If the GriBIL driver is installed correctly an infrared icon will appear in the Windows Taskbar next to the clock. Click the “Status” tab to display information about the GriBIL. If you move another infrared device into the receiving area in front of the GriBIL, and both devices are enabled the LED on the GriBIL will flash periodically to indicate that it is receiving data. The PC will make a sound to inform you once a connection has been established. The name of the other infrared device will be displayed on the Infrared Monitor status screen once a link has been established.

4e. Installation Instructions Windows 98 & Windows 98 SE

(a) From the Windows Start button select Settings and open Control Panel.

(b) Select the Add New Hardware icon, to start the Add New Hardware Wizard. Click the Next button for the first two screen prompts of the Wizard.

(c) After the wizard has searched for plug and play devices, select No, the device isn’t on the list, and click the Next button again.

(d) A new prompt will appear asking if you want Windows to search for new hardware. Select No, I want to select the hardware from a list, and click the Next button.

(e) The following screen will display a list of devices that can be connected to your machine.

(f) Scroll down the list and select Infrared Devices, then click the Next button.

(g) Ensure that the GriBIL Installation Disk is place into the floppy drive on your machine, and click the Have Disk.. button.
(b) Set the path in the search location box to A:\Win98, then click OK.

(i) Select Greenwich Instruments GirBIL Infrared Dongle as the device and click OK.

(j) The computer will now spend some time installing the files required for the GirBIL installation. You will probably need to have the original Windows 98 CDROM available for use when requested. Also, at any point you are asked to insert the Infrared Driver Disk, you must ensure that the search location is specified as A:\Win98.

(k) After a short while a prompt will appear requesting you to select a device. Make sure that the GirBIL is selected, then press Next.

(l) Next specify the COM port that you have physically connected the GirBIL to. e.g. if you were to connect the GirBIL to Serial Port 2 (COM2) you must specify COM2 in the set up procedure Click Next.

(m) When the Select Simulated Serial and Printer Ports Dialogue appears, it is normally okay to keep the default ports that the Wizard has recommended, again click Next.

(n) To finalise the installation process, click the Finish button, and after a few moments the infrared driver will be fully installed.

4f. Testing the GirBIL with Windows 98

After the GirBIL has been installed, as part of the process, a new icon will have been placed on the taskbar next to clock. Double click on the Infrared icon to open the Infrared Monitor. Click on the options tab and make sure that the device is enabled, then go back to the status tab. Place another device that is transmitting infrared in front of the GirBIL and the Infrared Monitor should display the name of the device on the screen. The GirBIL is successfully installed and ready to use.

If your device is not recognised, refer to the FAQ’s on page 17 and the Trouble Shooting guide on page 13 to locate the cause of the problem. Also check the Network settings in the Control Panel, which should have the Greenwich Instruments GirBIL Infrared Adapter listed as an Adapter. Click on it’s properties and check that under the Advanced tab that the properties are showing, Infrared Transceiver set to GirBIL Infrared Adapter, and Serial Port is set to the physical COM port that the GirBIL is connected to. If required you can specify a different COM port in this window.

4g. Installation Procedure Window 2000

Before installing the Windows 2000 Infrared Support, you must connect the GirBIL to a spare 9-way Serial (COM) port on the PC. If the port has a number (COM1, COM2, etc.) make a note of the number, this may be required later on in the installation procedure. If you are not certain as to which port you are using after referring to your user manual, you will have to try different options to find out which one works.

Note: The GirBIL is directly supported under Windows 2000. The diskette supplied is for Windows 95/98 and must not be used for Windows 90.

(a) Open the Windows Control Panel, by pressing the Start button, selecting Settings and Control Panel.

(b) Click the “Add/Remove Hardware” icon, which will open the first page of the Add/Remove Hardware wizard.

(c) After clicking the “Next” button a new screen will appear asking you to specify a Hardware Task. Ensure that the “Add/Troubleshoot a Device” is selected then click the “Next” button.

(d) Windows 2000 will take a few moments to try and look for Plug and Play devices, before displaying a list of hardware.

(e) Select “Add a New Device” from the list and click the “Next” button.

(f) A “Find New Hardware” window will appear in which you are presented with two options. Select the “No, I want to select the hardware from a list” option, and click the “Next” button.

(g) From the list of devices that appears on the screen, select “Infrared Devices” and click the “Next” button.

(h) After a few moments of hard disk activity, a list of manufacturers will appear on the screen. Select “Greenwich Instruments Ltd.” and “Greenwich Instruments GirBIL Serial Infrared Device” and click the “Next” button.

(i) Windows 2000 will confirm the device that you have selected. If it’s a GirBIL, go ahead and click the “Next” button. However if you have selected another device, you can click the “Back” button to return to the previous screen and change your selection.

(j) Again there will be a certain amount of disk activity while the drivers are copied to the system. If you have more than one Serial (COM) port in your machine you will be prompted to specify which COM port the GirBIL is actually connected to. After making any selections click the “Next” button.

(k) The final screen of the “Add/Remove Hardware Wizard” will appear, at which point you are prompted to click the “Finish” button. This completes the installation of the GirBIL.

4h. Testing the GirBIL with Windows 2000

Go to the Windows 2000 Control Panel and click on the “Wireless Link” icon. Select the “Hardware” tab, and you should see the GirBIL selected as the infrared device. If you see another device listed you will have to start the “Add/Remove Hardware” wizard again and choose to remove the device that you have installed.
To test the GirBIL is installed correctly; point the infrared window of another IrDA compatible device at the GirBIL. Ensure that the device you are using is enabled to send infrared data, and you should see an icon appear on the screen indicating that the two devices are communicating with each other. Note the LED on the GirBIL will only flash when it is communicating with another device.

If there is no activity on the screen check the following:

1) Ensure the device you are using the GirBIL with is transmitting infrared data.
2) Make certain the infrared window on your device is unobstructed and is pointing towards the front of the GirBIL.
3) Is the GirBIL plugged in securely to the connector on the PC?
4) Are you sure that the COM port specified during installation is the same as the port the GirBIL is actually connected to? If you want to change the specified COM port, click the “Properties” button, which will display the GirBIL’s details. In this section you can alter the Maximum Connection Rate, and the communications (COM) port that the device is connected to. Only applications that support infrared communications can use the GirBIL directly.

Note: Windows 2000 does not use virtual COM port.

4. Using the GirBIL with Windows 95/98 applications.

The GirBIL can be used with any application that supports Direct IrDA Infrared Communication. Additionally, most applications that can communicate over a null modem cable between two Windows 95/98 machines should be also be able to communicate over an infrared link. To use an infrared port you must specify the number of the virtual port, (e.g. COM4, LPT9, etc.), for the application to use. COM ports are used for serial data and LPT ports are used for parallel, or printer port, data.

Note: Do not specify the physical port the GirBIL is connected too as this will cause conflicts with the operation of the GirBIL.

As Personal Digital Assistants (PDAs) and Handheld Personal Computers (HPCs) become more popular, specific software to manage the exchange of data between machines is becoming more widespread and is often supplied with the machine. The software normally has facilities for communicating via infrared links that are IrDA compliant. For example, most Windows CE machines have infrared capability and the desktop software supplied with these machines have features to take advantage of infrared communications.

Note: IrDA is the name given to the Infrared Devices Association; a body set up to establish common standards for the exchange of infrared information.
Infrared Monitor recognises other infrared devices but whenever I try to exchange information with other devices the link is lost. If your computer is an older machine it may not have 16550 UART support - Fast Serial Ports. Instead it may support the slower 8250 UART. Check your hardware. If this is the case, for more reliable communications it is advisable to limit the connection speed of the GIBIL to 19,200 bps. Use Limit Connection Speed option and select an appropriate speed from the list available.

5a. PSION Series 5 / 5mx / 7 Additional Note.

At the time of writing (Jan 2000), infrared communications between a Psion handheld and a PC using PsWin is not a supported feature by Psion. However, on many PCs it is possible to use the GIBIL to exchange data with the Psion using PsWin. Our experience has shown that typically this is only in a relatively small number of cases that the link will not work with the Psion.

Infrared data transfer is only possible using Windows 95/98, and requires both the GIBIL driver and PsWin to be installed on the PC. The Psion handheld needs to have Message Suite 1.52 or later installed in it.

Note: Message Suite 1.52 and above provides an updated version of the Psion infrared driver, which although primarily addresses issues with Psion to mobile phone comms, does seem to help with Psion to PC comms.

5b. Establishing The Infrared Link

Right click on the PSION LINK icon next to the Windows 95/98 Clock. (This is the icon that resembles a straight line). Select "Close" from the menu options. Ensure that the GIBIL is connected to the PC and start the "Infrared Monitor" software from within the "Windows Control Panel". Click on the "Status" tab to view the current infrared link status. The red icon should flash green every few seconds to indicate that the PC is searching for an infrared device. If the icon has a red circle with a white cross through it, it means that you must enable the GIBIL from the Infrared Monitor's "Options" tab. Click the "My Psion" icon to start Psion on the PC. Select the Properties option from the File Menu. A "My Psion" properties window will appear allowing access to the "Connections" settings. Ensure that the infrared box is ticked. PsWin is now ready to connect to the Psion via infrared. If after trying to connect you experience difficulties maintaining a connection try altering the Baud Rate in the Pswin connections properties window. Switch on the Series 5 and tap on the orange status icon in the lower corner of the touch screen. Press the MENU key on the keyboard. Tap on "Tools" and select "Serial Link..." from the drop-down menu. Set the link to "Infrared" and the baud rate to "115200" then press "OK" button on the screen.

5c. Troubleshooting an Infrared Link with the Psion Series 5 / 5mx / 7

Please note, there may be issues when using the GIBIL with the Psion P5W. For example if the beam is interrupted during mid transmission the Psion handheld and PsWin may freeze operations and have to be restarted again. If you are having problems linking with PsWin, it may be necessary to change the link speed in the PsWin connection setup.
To access the connection properties, start the "My Psion" application on the PC, and select "Properties" from the "File" menu. The "My Psion Properties" window will appear. Select the "Connections" tab. Make sure that the "Infrared" box is checked and try changing the Baud Rate from "Maximum Attainable" to 115200. Reset the link on the Psion and try to start PsWin again after having set the new maximum speed. On most PCs this should enable successful links to be established. However on a few PCs it may be necessary to reduce the speed on the PC to 57600 Baud. Force you have established a link, and the beam path is broken, it may be necessary to restart PsWin and reset the "Remote Link" option on the Psion, in order to re-establish the link.

GirBIL

GirBIL Additional Information - Frequently Asked Questions

Before attempting to install the GirBIL on to a PC it is strongly recommended that you familiarise yourself with the installation procedure and how to use the Infrared Monitor. A full instruction manual in HTML and TEXT format can be found on the installation disk supplied with GirBIL.

What Operating Systems support using the GirBIL? - Using the appropriate driver software, the GirBIL can be used with Microsoft Windows 95, Windows 98, Windows 2000, and Linux. The GirBIL is not currently supported under Windows NT, Windows 3.1, and DOS.

Should the GirBIL's light flash when Infrared support is enabled? - No! The GirBIL's indicator will only flash when data is actually being received from an external IrDA compatible infrared device.

Does it matter what COM port I use connect the GirBIL to? - The GirBIL can be connected to any serial port as long as it is not being used by any other devices. You must however ensure that the port that the GirBIL is connected to is same as the port specified under the options tab of Infrared Monitor.

What is Infrared Monitor and how do I use it? - Infrared Monitor can be launched by double clicking the infrared icon in control panel, and is very useful for checking to see if an external infrared device is communicating with the GirBIL. It has a status screen that will display information about any infrared devices trying to communicate with the PC. Additionally it has an option tab for adjusting the control parameters of the GirBIL. Basically if it is possible for Infrared Monitor to detect external infrared devices, this indicates that the GirBIL has been installed correctly and is functioning as expected.

I've followed the installation procedure, but I'm not sure if the GirBIL is working properly. What can I do to check this? - Select Device Manager, by clicking the System Icon, in the Windows Control Panel. This should display a whole list of items installed and connected to the PC. Then should be an icon called infrared. Click this icon to reveal the name of the infrared driver installed on your PC. If the GirBIL has been installed correctly it should show that a "GirBIL Infrared Adapter" is installed. If you see another device displayed, or you don't see the infrared icon at all, you will have to reinstall the GirBIL driver again, making sure that both "Greenwich Instruments Ltd" and "GirBIL" are selected during the installation process. Before reinstalling the software ensure that any current versions of Microsoft Infrared Support are removed by using the Add/Remove Programs, within the Control Panel.

I cannot enable the infrared device because a port is busy? - Make sure that no other software is trying to access the port that the GirBIL is physically connected to. Quite often if you have the PC communications software that was supplied with the handheld you are using, installed on the PC, the software automatically tries to gain access to the serial ports. Therefore it is necessary to ensure that in any such software serial port access is disabled, or is configured not to use the same serial port as that the GirBIL is connected to.
What is the difference between a normal serial port, and a virtual serial port and why does Windows Device Manager show extra ports after the GirBIL has been installed?

A normal serial (COM) port is that which is actually physically provided on the back of the PC being used. The Microsoft Infrared Support, upon which the GirBIL device driver is based, provides virtual COM and LPT ports, in order that standard applications can communicate via infrared. The GirBIL driver uses the standard COM port to which the GirBIL is physically connected to provide the extra virtual ports. For example, the standard Windows Hyperterminal application does not directly support infrared data communications. However with the additional virtual COM port (normally COM4 or COM5) selected, the Microsoft Infrared Support carries out a translation between the infrared and standard serial data, in order that application can communicate using infrared. This is transparent to the application, which thinks it is just using another standard serial port.

What is the minimum distance that I can place my device from the GirBIL? - For optimum operation it is recommended that infrared devices are located in front of the GirBIL at a distance of at least 4 inches, (100 mm).

The GirBIL only seems to pick up data from devices places within 500mm of its window. Is there a fault with my GirBIL? - The GirBIL is classified as being IrDA 1.0 compliant, which means it can send and receive data over a distance of 1 metre. Many handholds are what is classed as IrDA 1.2 compliant. IrDA 1.2 requires that devices should be able to send and receive data over a distance of 300 mm. Handheld manufactures quite often use IrDA 1.2 to help preserve the battery life of the machines.

Will the GirBIL work with my TV remote? - No! The GirBIL will only function with other IrDA infrared compatible devices.

Does the 3Com Palm work with the GirBIL? - IrDA infrared support was added to the Palm range from OS version 3.3 or above. If you have a Palm with an earlier Operating System, you can normally upgrade to the latest OS by obtaining the relevant files from the www.palm.com website.

---

A final word about Virtual Ports and Direct Infrared Support.

Windows software can access the Microsoft Infrared Driver in one of two ways:

The first method is by Direct Infrared Support, which is used when the program has direct access to the machine's infrared port. A program using this type of access can normally be identified by software that allows "Infrared" to be specified as a communications option.

The other method available to software running under Windows 95/98 only is to use a feature, which allows software to use simulated "Virtual Ports" to communicate with. The idea behind "Virtual Ports" is that any software that can access a serial (COM) or printer (LPT) port can communicate to an infrared device using the simulated ports. The software application still sees all the ports as standard devices, but the Microsoft Infrared Driver actually translates normal port data into infrared data required to communicate to another infrared device. This allows older software that does not have direct infrared support to have access to infrared. However, this type of infrared support is now generally considered to be confusing to configure.

Microsoft is encouraging all new software developers to move away from using Virtual Ports, and to start to use the preferred Direct Infrared Support option. The main reason behind this move is that it makes setting up devices much simpler to understand. For this reason Virtual Ports are not supported at all under Windows 2000.

Therefore if you want use software with infrared on Windows 2000, you must ensure that you have a software version that has direct infrared support. Microsoft and 3Com have updated their PC Synchronization software for their handholds to use Direct Infrared. For information about these and other manufacturers' devices, it is probably best check out the web sites of the manufacture concerned.